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Foreword 
Thank you for choosing ColorLogic’s ColorAnt. Reaching higher 
quality in production environments has never been easier.
ColorAnt is the ultimate color management tool to manipulate, 
analyze and optimize measurement data including RGB, CMYK 
and Multicolor.
Use ColorAnt to create special measurement charts, measure 
color patches, and to check measurement data prior to profiling 
to avoid issues such as mis-measurements or inhomogeneous 
data. ColorAnt can be used to average several measurements 
together when required prior to profile creation. The 
quality of ICC profiles depends strongly on the quality of the 
measurement data used to create them. By adding analysis and 
optimization of measurement data, profile quality will improve 
which also leads to a higher production safety.

Enjoy analyzing and optimizing your measurement data!

Your ColorLogic Team
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INSTALLING 
COLORANT

Getting Started 
with Colorant
Installation, requesting demo licenses, 
loading licenses
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Installing ColorAnt 
System requirements
macOS 
10.7.5 or later - (Intel only)
Windows
Windows XP, Vista, Windows 7, 
Windows 8, Windows 10

Installers for the respective platform 
installs the program by default in 
either the 
Applications 
folder 
(Macintosh) or 
the Programs 
folder 
(Windows). 
Begin in-
stallation by 
double-click-
ing on the 
ColorAnt 
installation 
package.

After ac-
cepting the 
Software License Agreement, select 
the destination volume and click 
Install. 

Computer vs USB 
dongle license
Computer based ColorAnt licens-
es refers to a specific computer on 

which ColorAnt was installed and 
can be requested for temporary test 
purposes. Computer licenses are also 
advantageous if the computer has 
no USB ports or no space for a USB 
dongle, i.e. a rack server.
USB dongle licenses are serialized 
to a USB dongle. The USB dongle is 
shipped with a permanent license and 
permits use of ColorAnt on different 

computers. To assign the license to 
the USB dongle, the dongle must be 
connected before starting ColorAnt.

Demo license request
ColorAnt allows users to 
automatically request a 14 day demo 
license to evaluate ColorAnt.

01 INSTALL

Registration Window
FIG 1.1
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To request a demo license follow 
the steps below:

1. Click the registration button 
located on the lower left-hand corner 
of the Main Navigation Panel.

2. Click on the Demo license 
request tab. 

3. Enter all required information. 

4. When your location is chosen, 
ColorAnt will show the available 
dealers for your region. Select a 
dealer and click Send direct request. 
A demo license will be automatically 
sent to the email address supplied in 
the contact form.

5. Save the license file contained in 
the email (indicated by the ending 
*.lic) to your 
system. 

6. Under 
License 
details in the 
Registration 
window and 
select the .lic 
file.

After installing the demo license file, 
the expiration date of the demo 
license is shown below the License 
details (Fig 1.2).

Restrictions with Demo 
licenses and ColorAnt

ColorAnt demo license gives users 
a 14 day evaluation period to try 
all the functions of ColorAnt within 

the application. The demo license 
permits saving and exporting of data.

Purchasing ColorAnt

ColorAnt is available in 2 packages, M 
or L. Click on Buy ColorLogic prod-
ucts under License details or Demo 
license request in the Registration 
window.

A list of ColorLogic resellers will 
open in your browser, then locate the 
appropriate dealer for your country 
or region. 

Installing a permanent 
license 

A permanent license provided by the 
individual dealer will be supplied after 

purchasing 
ColorAnt. 
The perma-
nent license 
is available 
in the form 
of a com-
puter-based 
license or a 

dongle license (see previous section).

After purchasing the software, a 
permanent license file (.lic) will 
be sent via email license. Load the 
license file under License details in 
the Registration window.

After installing the permanent license 
file, the licensed modules are dis-
played under the License details.

License status information
FIG 1.2
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ColorAnt PACKAGES

ColorAnt's Packages
ColorAnt's packages standard features that address every aspect of 
measurement data correction.

ColorAnt Documentation
ColorLogic's ColorAnt offers some of the most powerful and advanced 
measurement data tools in the industry today. Integrated within ColorAnt 
are help buttons represented with the ? icon, with detailed and current 
information.

Automatic Updates
ColorAnt includes an automatic update function that can be enabled or 
disabled by going to Help>Check for Update.

COLORANT M COLORANT L

STANDARD FEATURES
All Features 

of ColorAnt M 

Viewing, Comparing, Reporting
Multicolor Custom Chart 

Generation
Includes Multicolor chart generation

Correction, Smoothing, Averaging, 
White and Black Correction, 

Brightener, Rescale, Tone Value, 
Link

Edit Primaries
Multicolor Support

 Edit Primaries for CMYK and Multicolor

Measure Tool
Measure all charts and color spaces

Merge Multicolor Charts
 Combine charts by channel names

Edit Primaries
Edit Primaries for CMYK

Color Editor
 Edit Color for CMYK and Multicolor

Custom Chart Generation
Color spaces supported: Gray, RGB, CMYK

Embed CxF/X-4
 Embeds spectral spot colors in PDF files

Color Editor
Edit Colors for CMYK only

CIE Conversion
Edit illumination and Standard Observer
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USING THE 
SIDE BAR

ColorAnt's Side Bar
Access all of ColorAnt functions 
from one central location.
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02 SIDEBAR

Auto

RescaleTone ValueBrightener

Custom
Chart

MeasureExport
Chart

Report

Edit 
Primaries

Registration Preferences

Automatic Correction

Editing

Merging and Conversion

Data Import/Export

Embed CxF/X-4

Color Editor

Averaging Link ICC
Transformation

CIE
Conversion

ICC

Redundancies Correction Smoothing White/Black
Correction

CxF

PDF



SIDEBAR

ColorAnt's Side Bar
ColorAnt's Side Bar allows quick access to all tools from a 
central, easy-to-use location.

Auto
Correct measurement data 
automatically

Custom Chart
Create custom charts for 
measurement

Export Chart
Export custom chart for printing  
and measuring

Measure
Measure printed charts or 
ambient light

Report
Generate detailed reports on 
measurement data

Embed CxF/X-4 
Embed CxF/X-4 spectral data in 
pdf files

Redundancies
Correct redundant patches by 
averaging data

Correction
Correct and detects faulty mea-
surements and inconsistent data

Smoothing
Smooth and correct uneven 
curves

White/Black 
Correction
Apply manual correction to 
white and black areas

Brightener
Remove optical brightener from 
measurement data

Tone Value
Correct measurements as if 
printed to a specific reference

Rescale
Recalculate data to a different 
color chart

Edit Primaries
Add, remove, and exchange 
primaries or substrate in an 
existing measured test chart 
Color Editor
Edit colors to match a 
reference file

Average
Average several data sets into 
one data set

Link
Combine multiple charts into 
one measurement file

ICC Transformation
Use ICC device and DeviceLink 
profiles to test impact on data

CIE Conversion
Change the standard observer 
illumination from standard D50

11

Registration
Access the  Registration and 
license dialog
Preferences
Preferences - Customize various 
ColorAnt settings

Online Help 
Get detailed help by 
clicking the ? 

?

CxF

PDF
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Data Sets
Select the data set (or sets) to 
process. The Data Sets section of 
the main window (Fig 2.1)displays 
pertinent information about the 
measurement data including: number 
of color patches, color model (Lab, 
CMYK, RGB, Multicolor), measure-
ment value type (colorimetric = Lab 
- spectral = Remission). 

History
The tools applied to the measure-
ment data are shown in the lower 
right side History window. Clicking 
on an action item in the History 
window (either above or below the 
current state) gives the user control 
over individual corrective tasks.

SIDEBAR

Data Sets, History and Saving History
FIG 2.1
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Save History Log and 
Averaging Report 
Save History Log 
is available at the 
bottom right (Fig 2.3)
of the main dialog. 
This saves all modifi-
cations applied to all 
files in a detailed PDF 
document. When 
double-clicking an 
single entry in the 
History section, a di-
alog pops up showing 
the settings applied to 
the data at a specific 
step. The single step 
can be saved with 
Save Log. 
Averaging Features

The averaging log 
contains (Fig 2.2) 
detailed reporting 
with sample colors 
(similar to the Report 
feature) comparing 
the averaged data 
and providing process 
control statistics. 
Standard deviations 
(sigma) for Density, 
dE and dH/dL. This 
allows users to easily 
see colors with large 
deviations which would not be obvi-
ous by visually verifying values.

  

SIDEBAR

Save History Log with Averaging Report
FIG 2.2

Statistics:
CMYK PatchID L a b Density

(±Sigma)
(±2Sigma)
(±3Sigma)

dE
(±Sigma)
(±2Sigma)
(±3Sigma)

dH/dL
(±Sigma)
(±2Sigma)
(±3Sigma)

Substrate/Paper white
0 / 0 / 0 / 0 69 95.33 0.08 -2.07 0.00

(±0.00)
(±0.00)
(±0.00)

0.36
(±0.06)
(±0.11)
(±0.17)

0.29 dH
(±0.18)
(±0.36)
(±0.55)

Maximum
100 / 0 / 0 / 0 1 56.47 -38.72 -48.77 1.00

(±0.00)
(±0.00)
(±0.00)

37.48
(±15.76)
(±31.53)
(±47.29)

36.90 dH
(±16.24)
(±32.47)
(±48.71)

Full Primary
100 / 0 / 0 / 0 1 56.47 -38.72 -48.77 1.36

(±0.08)
(±0.16)
(±0.24)

37.48
(±15.76)
(±31.53)
(±47.29)

36.90 dH
(±16.24)
(±32.47)
(±48.71)

0 / 100 / 0 / 0 6 48.82 75.19 -3.58 1.62
(±0.02)
(±0.04)
(±0.06)

0.56
(±0.16)
(±0.32)
(±0.48)

0.19 dH
(±0.14)
(±0.29)
(±0.43)

0 / 0 / 100 / 0 11 89.30 -5.42 92.54 0.96
(±0.02)
(±0.04)
(±0.06)

0.58
(±0.11)
(±0.22)
(±0.32)

0.03 dH
(±0.04)
(±0.07)
(±0.11)

0 / 0 / 0 / 100 21 17.31 0.19 -0.03 1.57
(±0.02)
(±0.04)
(±0.06)

1.33
(±0.46)
(±0.92)
(±1.38)

-0.16 dL
(±0.46)
(±0.92)
(±1.38)

Full (CMY) Secondaries
100 / 100 / 0 / 0 25 26.01 21.60 -46.93 0.99

(±0.00)
(±0.01)
(±0.01)

1.64
(±0.45)
(±0.90)
(±1.35)

0.38 dH
(±0.27)
(±0.55)
(±0.82)

100 / 0 / 100 / 0 35 50.80 -66.89 27.14 0.99
(±0.01)
(±0.01)
(±0.02)

1.09
(±0.40)
(±0.80)
(±1.20)

0.12 dH
(±0.48)
(±0.97)
(±1.45)

0 / 100 / 100 / 0 30 47.03 68.78 49.94 1.00
(±0.00)
(±0.00)
(±0.00)

2.31
(±0.80)
(±1.60)
(±2.41)

0.08 dH
(±0.70)
(±1.40)
(±2.10)

Maximum Primaries
100 / 0 / 0 / 0 1 56.47 -38.72 -48.77 1.36

(±0.08)
(±0.16)
(±0.24)

37.48
(±15.76)
(±31.53)
(±47.29)

36.90 dH
(±16.24)
(±32.47)
(±48.71)

Maximum (CMY) Secondaries
70 / 0 / 70 / 0 36 63.74 -39.86 22.03 0.83

(±0.01)
(±0.01)
(±0.02)

2.02
(±0.50)
(±1.00)
(±1.51)

0.89 dH
(±0.72)
(±1.44)
(±2.16)
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View and Compare Data 
When viewing measurement data, 
the View Options in the 2D and   
tabs have been updated with addi-
tional color channel check boxes for 
the primary colors available in the 
loaded data set. The color 
channel check boxes can be 
combined with the above 
color filters so that only 
the Multicolor Primaries or 
Secondaries can be shown. 
This greatly facilitates finding 
and viewing patches. The 
removed viewing options, 
Duplex and Triplex known 
from previous versions of 
ColorAnt, can be com-
pensated by selecting 
appropriate color channels 
individually (e.g. Cyan + 
Black shows duplex combi-
nations and Cyan + Magenta 
+ Black shows triplex combi-
nations). Both options were 
removed to gain space in the 
user interface. In addition, 
the filters work in combina-
tion with the color channels. 
If, for example, the check 
box Secondaries is enabled, 
the check boxes Primaries 
and White are automati-
cally enabled. They can be 
disabled if only two color 
combinations (Secondaries) 
are to be highlighted. The TVI tab 
allows users to switch between the 
typical density based dot gain curves 
according to Murray Davies or the 
modern colorimetric dot gain curves 

according to ISO 20654 (SCTV). 
Linear dot gain curves according to 
ISO 20654 would show a straight 
horizontal line.

ColorAnt History Log 2018-07-23

Load Data
Loaded file:
/Users/jamesgeorge_1/Google Drive/ColorLogic/Testing/ColorAnt_Tests/00_Files/Digital printer random.txt

ChartInfo
REFERENCE_PROFILE Demo-Digital printer random_OriginalTAC250.icc
CREATED 2013-08-08T10:53:27
ORIGINATOR CoPrA
FILE_DESCRIPTOR Unknown

Redundancies
Processed file:
/Users/jamesgeorge_1/Google Drive/ColorLogic/Testing/ColorAnt_Tests/00_Files/Digital printer random.txt

Resulting file:
Digital printer random-RemovedRedundancies.txt

Settings:
Mode: 0
Mode description: Auto (depends on the number of redundant patches)
Remove duplicates: No
DeltaE Method: Delta-Auto

Statistics:
Quality: < 0.01
Count: 404.00
Group count: 91.00
Average delta: 0.18
Maximum delta: 7.03

Correction
Processed file:
Digital printer random-RemovedRedundancies.txt

Resulting file:
Digital printer random-RemovedRedundancies-Corrected.txt

Settings:
Mode: 1
Mode description: Correct bad measurements
DeltaE method: Delta-Auto
Protect lights (%): 0

Data Sets, History and Saving History
FIG 2.3
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 View and Compare 
Tools
Advanced viewing options 
for ColorAnt's tools located 
at the bottom of the main 
window that can be enabled 
for both viewing measurement 
data (View) and comparing 
pre and post comparison of 
measurement data (Compare).
Absolute or Relative Density 
can be set in ColorAnt's 
Preferences

2D highlight with 
Color Filter
The Color Filter highlights 
selected colors in 2D and 3D 
views. View by full primaries, 
limits, selected channels, 
primaries, secondaries, paper 
white or black. Other custom 
settings are also available.

3D viewing options
The Color Filter highlights se-
lected colors in 3D views. Zoom 
and rotate the model by using 
the sliders. Click the Compare 
ICC profile to compare the two 
in the window. The same filter 
options are available in the 2D 
view.
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Curves
View the linearity curves from 
white to all 100% primary colors, 
(including multicolor data). 
Visualizes data and assists with 
analyzing non-smooth gradation 
curves. Choose from ColorLogic 
Default, ISO 20654 (SCTV) or 
Tone Value. 

TVI View options
Analyze tone value variation 
curves (TVI). The tone value 
curve works in conjunction with 
the curve view or any other cor-
rection which will effect the TVI. 
Choose either Murray-Davies or 
ISO 20654 (SCTV) methods

Spiderweb
The top view of the color 
space in a a*-b* diagram. The 
measured or optimized col-
or patches are arranged in a 
spider web configuration. Verify 
changes in the View dialog by 
moving forward or backward in 
the History list.
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USING
COLORANT

Automatic Correction
Correct and optimize measurement 
data with one click

View
View measurement data with 2D, 
3D, spider web and curves

Compare
Compare measurement data 
before and after correction
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Working with ColorAnt
ColorAnt’s main window is divided 
into 3 sections. All tools are located 
and grouped by (Fig 3.1) function on 
the left side, measurement data is 
shown in the Data Set section on the 
right hand side upper window of the 
application window. Measurement 
data can be loaded or saved via the 
File menu or by dragging & drop-
ping data to the Data Sets window. 
Tools applied to the 
measurement data 
show are shown in 
the lower right hand 
side History win-
dow. Clicking on an 
action item in the 
History window (above or below the 
current status) gives the user control 
over individual corrective tasks.

Automatically 
correct and smooth 
measurement files
Load the measurement data file. 
Click on the Auto button and on the 
OK button. Each tool that is applied 
is displayed in the History section. 
ColorLogic recommends completing 
this process running by a Report for 
detailed results and further recom-
mendations for your measurement 
data.

Recommended manual 
working method
Opening or Importing data

Measurement data can be loaded or 
imported through a variety of ways in 
ColorAnt. Simply open the data file 
(File>Open) or Drag and Drop to the 
Data Sets window. Predefined data 
sets and recently opened files are 
also available via the File menu. 

Acquiring data 
through 
measuring

Measurement 
data is acquired 
with the Measure 

tool and transferred to ColorAnt. 
Measurement data files Measure tool 
are stored in the Users/Documents/
ColorAnt/MeasurementData folder.
The Data Sets section of the main 
window will display pertinent infor-
mation about the measurement data 
including: number of color patches, 
color model (Lab, CMYK, RGB, 
Multicolor), measurement value type 
(colorimetric = Lab - spectral = 
Remission).

03 USING
COLORANT

Using Auto is the fastest 
method to get high quality 
results
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Tools located on the left will be 
highlighted when applicable to the 
measurement data, tools not accessi-
ble are grayed out. Access the tools 
by first highlighting the data (or multi-
ple files e.g. linking or merging several 
data sets together) and right click. 
When multiple data sets are present 
and no set is selected, corrections 
are applied to all measurement files.

To add reference files for addition-
al or custom profiling test charts 
and color wedges accessible using 
the File/Open predefined or the 
the Rescale tool - add the CGATS 
1.7 compatible TXT file to Users/
Documents/ColorAnt/Wedges 
folder. 

Viewing and 
Comparing Data
Advanced viewing options for 
ColorAnt include tools located at the 
bottom of the main window that can 
be enabled for both viewing mea-
surement data (View) and comparing 
the original and post comparison of 
measurement data (Compare).

The View window includes options 
for 2D, 3D, Spider Web and TVI 
curve options to facilitate compre-
hensive measurement data analysis. 
Color Comparison allows the user 
to view measurement data (Fig 3.2) 
before and after optimization. The 
comparison window also allows 
the user to view the actions taken 
to achieve the optimized data (e.g. 

Main window with Data Sets section
FIG 3.1
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File Name Correction, File Name 
Smoothing). The Mark from and 
Mark to slider displays various levels 
of DeltaE deviations.

Saving or exporting 
measurement data
Once a tool or tools have been used 
to correct or optimize data, the name 
of the data will be appended with the 
tool(s) that have been applied (e.g 
Data_smoothed_corrected).
Save the optimized measurement 
data by going to File and choose 
Save as. Additional export options 

allowing conversion of spectral data 
to Lab or Density only. Other save 
as options include CGATS compati-
ble TXT file, CGATS XML, Named 
Color ICC profile, CxF compatible 

CXF file format, Photoshop ACO, 
color table, Adobe ASE or as GMG 
CSC file.

Generate Reports
ColorLogic recommends using the 
Report tool both on the initial data 
import and after the measurement 
data has been optimized.

Compare data before and after correction
FIG 3.2
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PRINTER PROFILING

DATA 
IMPORT & 
EXPORT

Create Custom Chart
Generate custom patches 
for test charts

Exporting Charts
Create custom size charts for various 
measurement instruments

Creating Reports
Create detailed reports from 
measurement data

Embed CxF/X-4
Embed CxF/X-4 data into PDF files

CxF

PDF

Measure
Measure test charts
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Custom Chart
The Custom Chart tool is designed 
for creating reference files for test 
chart generation. To define a custom 
test chart for profiling, a reference 
file containing the device data for the 
color space is required. Important: 
Creating multicol-
or charts requires a 
ColorAnt L license.
Depending on the 
selection of color space, 
the Custom Chart dialog 
provides several options:
Gray, RGB and CMYK: 
Define the Number of 
Patches and click OK. 
Select the desired Color 
Space from the chooser.
CMYK: Choose the lin-
earisation from another 
measurement data set 
or from another print 
run as a starting point. 
To use the linearisation 
feature, load the appro-
priate measurement 
file in ColorAnt before opening the 
Custom Chart tool and select the file 
in the Color Space chooser.
Multicolor Charts
Modifying settings:

Select the desired Color Space, for 

example to create a 6 color profiling 
chart, ColorAnt will display a pre-
defined color order, in this example: 
CMYK+Pantone Red and Green. 
The Eyedropper function allows 
reordering the inks. To exchange the 
5 channel which is Red with Green, 
similar to fig 4.1 click on the Red 

Eyedropper Icon and from the Colors 
section select Green by clicking on it.
Mode:

Choose one of the presets based 
on the purpose of the test chart: 

04 DATA IMPORT 
& EXPORT

Custom Chart Dialog
FIG 4.1
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Profiling, Flexo profiling, Profile 
updating, Linearization.

Choosing the number of patches
Choose from any of the four pre-
defined settings, Small, Medium or 
Large. For a specific 
number of patches 
choose Custom and 
enter a number in the 
box.
Changing or defining 
the channel names

To change channel 
names, click the Pencil 
icon, e.g., click the 
green channel and 
type in the new name 
as shown in fig 4.2.
Define the channel 
name of each channel, 
(including or exclud-
ing CMYK) enter 
the name in the text 
field or click on the 
eyedropper icon and 
select a color from 
the pop up dialog that 
matches closest.
Linearization

ColorAnt provides intelligent settings 
that provides users a starting point 
for typical use cases such as creating 
linearization test charts, profiling test 
charts, special profiling test charts 
for Flexo printing and updating of 
profiles. Number of Patches chooses 
the optimal number of patches for 
specific profiling situations. More in-
formation on this topic can be found 
in the Online Help.

Note: This option is useful with 
difficult print processes that are 
challenging to profile without 
linearization or having very high dot 
gain. ColorAnt uses a very smooth 

linearization to avoid inconsistencies 
in the curves.
Once the color space, channel names 
and the Number of Patches are 
defined, click OK and calculate the 
reference file. The reference file will 
appear in the Data Sets section. Save 
the file if necessary for other chart 
generation tools. To create a test 
chart within ColorAnt, select the 
reference file and click Export Chart.

Editing primary color names
FIG 4.2
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Export Chart
Export Chart allows creation of test 
charts as TIFF, PSD or PDF files.
At the top a Preset changing all the 
settings can be selected, manual pre-
sets can be created, saved or deleted. 
The largest section covers options 
for Chart Dimensions, Patch Sizes 
and additional Options. The section 
on the bottom provides information 
of how many files will be created 

with the chosen Preset, settings and 
buttons to Cancel or create (Start) 
the test charts. The tool is optimized 
to work with most of the instruments 
supported in the Measure Tool. The 
Custom Chart tool fills the full chart 
width with patches minus margins 
for the numbering. Instruments that 
do not have width limitation (no 
ruler required) can benefit from this 
feature.

The Ink Limit option allows the user 
to take into account special printing 
processes that can't handle 400% ink 
on paper/substrate. Typically each 
of ColorLogic’s CMYK and multicol-
or test charts have patches with a 
maximum of 400% ink. If a 400% ink 
limit is too high for the press, or the 
user would like to define another ink 
limit, the user can enter the desired 
Ink Limit. The resulting chart will 
have ink limit integrated. Use the 

exported reference file for measuring 
and profiling. 

Quick Start Procedure 
Step one: Select the reference file 
that was created with the Custom 
Chart tool or a reference file from 
another source.

DATA IMPORT/EXPORT

Export Chart
FIG 4.3
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Step two: Choose either one of the 
presets, or define a custom size and 
patch width.
Step three: Define the number of 
patches to be produced.

Measuring test charts
The ColorAnt Measure tool direct 
ly measures test charts for profile 
creation. 

Productivity Feature: When 
measurement data is loaded into 
the Data Sets window and Measure 
is selected, the previous chart and 
measurement device by default 
are automatically loaded into the 
Measure tool.

Quick Start Procedure
To Measure:

Step one: From the ColorAnt 
Data Import/Export module, click 
Measure. Step two: Connect to 
your device, and double click the first 
patch to begin measuring (may vary 
by instrument). To select a different 
chart for measurement, select the 
Chart from the dialog. For custom 
charts including ColorLogic's test 

charts, click Load and the select the 
desired chart from the pull down 
menu.
3. Select the measurement 
device under Selection and select 
the measuring mode (M1, M0 or M2 
if applicable). or task.  
4. Select the method of scanning: 
by Line by Line, Patches Column by 
column, Scan Rows or Scan Columns.  

DATA IMPORT/EXPORT

Measure Tool dialog box
FIG 4.4



5. Begin measuring: As you begin 
measuring with the options chosen, 
grayed out patches are replaced by 
measurement data. Continue mea-
suring until completed.
6. Transmit Data: When measur-
ing is completed, press Transmit to 
copy the data into 
ColorAnt.

Report
ColorAnt offers 
detailed reporting 
for measurement 
data analysis and 
provides the user 
with corrective 
recommendations for 
measurement data. 
Users can customize 
the logo and report 
title. Reports can be 
generated as pdf files 
or .xml data.
Features of 
ColorAnt's Report 
tool include Tone 
Value increase chart 
and the option of utilizing a lay-
ered PDF to view combinations of 
channels. 
ColorAnt will report the presence of 
optical brightener the deltaE variance 
and the corrective action needed to 
improve the measurement data.
Other features in ColorAnt are avail-
able via ColorLogic's Online Help.

Embed CxF/X-4
Embeds CxF/X-4 compliant spectral 
data into pdf files. Embed CxF/X-4 

is only available if the data selected 
in the Data Sets window contains 
spectral data that is compliant with 
the following standards: 
CxF/X-4b single patch 
characterization (full tone only)
CxF/X-4a single background 

characterization (full tone and 
gradient on white)
CxF/X-4 full characterization (full 
tone and gradient on white and black

Quick Start Procedure
The tool will list all the spot colors in 
the PDF file vs the names that match 
the CxF/X-4 data(Fig 4.5). A warning 
message is displayed when conflicts 
occur. 
When the spot colors match up, 
press Start.
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CxF/X-4 Embedding
FIG 4.5
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EDITING
TOOLS

Redundancies
Remove redundant 
patches

Brightener
Correct for 
Optical Brighteners

Correction
Detect and 
correct bad data

Tone Value
Correct data to a specific 
print condition

Smoothing
Smooth the characteristics 
of measurement data

Averaging
Average multiple data sets 
into one data set

Rescale
Recalculate data to a different 
color chart

Link
Combine separately 
measured charts

White/Black 
Correction
Correct to white and black point

ICC Transformation
Convert device data 
with ICC profiles

Color Editor
Convert spot colors to target 
profiles

Edit Primaries
Change primary colors and 
recalculate measurement data

CIE Conversion
Convert measurement data to 
a different viewing condition
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Redundancies
Corrects color patches by averaging 
the redundant patches and replacing 
with the same value.

Correction
The Correction tool detects faulty 
measurements or inconsistent mea-
sured values and replaces the data 
with expected measurement values. 
Use the Protect Lights feature to 
exempt Flexo data bumps. 

Smoothing
Corrects inhomogeneous measure-
ment data and non-smooth curves 
by interpolating existing smoothed 
data. The Auto correction uses the 
maximum slider setting. Use the 
Protect Lights feature to exempt 
Flexo data bumps for being uninten-
tionally smoothed.

White/Black 
Correction
Apply manual corrections to the 
most white and darkest color 
patches, typically the paper or 
other substrates. The White/Black 
Correction tool is designed to be 
used only on a single measurement 
file.

Brightener
Step one: Analysis

Brightener correction analyzes the 
remission curve of the paper white to 
ascertain whether the paper contains 
optical brighteners or blue-colored 
paper. 

Tone Value Dialog
FIG 5.1
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Step two: Correction

Correction will be applied if optical 
brightener has been detected. The 
correction can be adjusted via a 
slider control and at 100% setting, a 
similar result will be achieved as if the 
paper were measured with a UV cut 
filter.

Tone Value
The Tone Value tool corrects 
measurement data to a specific set 
of curves. Data is corrected with 
a "what if " the data was printed to 
(e.g. G7, 
ISO 20654 
SCTV) 
specific 
conditions. 
The Protect 
Lights 
slider can 
be adjusted 
to accom-
modate the 
highlights of flexo data.  
Three options are available:

Correct according to a given 
profile:

Specify a profile and measured values 
are adjusted to achieve the same 
tone value increase curves as those 
with the standard profile that was 
chosen. 
Correction according to: 

Tone value curves are calculated to 
match the requirements of G7 Gray 
Balance, ISO 20654 (SCTV), G7 and 
ISO 20654 (SCTV) or ISO 20654 
(SCTV) multicolor. 

Correction according to TVI 
targets

Manual editing of each channel (Fig 
5.1) allows the user to predefine the 
tone value increases that should be 
incorporated in the measurement 
data.

Rescale
ColorAnt can calculate large test 
charts (Fig 5.2) that can be used for 
profiling from small chart measure-
ment files. Some printing processes, 
(e.g. flexo printing on uneven ma-

terials) pose 
challeng-
es to an 
artifact-free 
printing 
ECI2002 
test chart. 
An effective 
approach to 
measuring 
large charts 
would be to 

place several small test charts, e.g. 
ColorLogic Profile Updating strips on 
one page, measuring the test strips 
and, averaging them in ColorAnt and 
then scaling up to a large ECI2002 
test chart with the Rescale tool.

Averaging
Average several measurement files 
(e.g. press runs) of the same test 
chart.

Link
Average multiple test charts into one 
large measurement file. The Link tool 
should be used in conjunction with 
the Redundancies tool.

Rescaling a chart to an IT8.7-4
FIG 5.2
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ICC Transformation
Use both ICC device and DeviceLink 
profiles on reference data (device 
data like CMYK or RGB) to test the 
impact of an ICC color conversion 
with up to three profiles.

CIE Conversion
The CIE Conversion tool converts 
spectral remission data with a differ-
ent Illuminant and 
Observer angles 
(e.g. D50, D65)
CIE Conversion 
also supports 
ambient light 
measurements 
from supported 
instruments via 
the Measure Tool. 
The readings can 
be saved separate-
ly for later use.

Edit 
Primaries
The Edit 
Primaries tool (Fig 
5.3) allows users 
to add, remove, 
and exchange 
primaries or the 
paper/substrate 
in an existing 
measurement data. In typical print 
production, adding or swapping ink(s) 
requires the expense of printing a 
complete, full size test chart. The 
Edit Primaries tool simply requires 
the spectral data of the new ink(s) 
to be added or exchanged. Edit 
Primaries not only exchanges inks 

but also recalculates all overprints 
based on intelligent spectral color 
models. One of the major features of 
the Edit Primary tool is the ability to 
dynamically choose the best patches 
from the data provided. The more 
complete the data that is provided 
to the Edit Primaries tool (spectral 
data is preferred) the more accurate 
the results. Items that will improve 

are: the exchange of gradations of the 
primary color, overprint information, 
e.g the primary combined with black. 
If the data that was chosen contains 
overprints, such as secondary colors, 
the Adapt Secondaries feature will 
take the additional data into account. 

Edit Primaries Dialog
FIG 5.3
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Scenarios for potential efficiency 
gain with the Edit Primaries tool in 
production :
Modify channel names: Reorder 
channel names with-
out modifying data
Variance in press 
condition: The 
characterization press 
run is slightly deficient 
in solid ink density or 
hue on one or more 
colors.
Exchange of paper/
substrate: The inks 
are the same but a 
slightly different paper 
shall be used.
Exchanging inks 
in a print pack-
aging production 
environment: 

Create a new profile 
that swaps in e.g. 
Blue for a Cyan or a 
Rhodamine Red for 
Magenta.
Adjusting the print 
sequence: Allows improved over-
print calculations.
Flexibility for the packaging 
manufacturer: Create different 
color variants from a full size 7 color 
press characterization data set by 
deleting channels to building new 
characterization data sets without 

printing a new test chart. For exam-
ple, from an original 7C data set (e.g. 
CMYK+Orange+Green+Violet) build 
variants for CMYK only, CMY+Violet, 
CMYK+Orange+Green or other 

combinations. The production facility 
would need to ensure the press is 
stable and depending on the color 
needs of the job(s), and print select 
the profile with the least amount of 
channels. 
Increasing CMYK gamut: Adding 
a 5th, 6th or 7th color to the CMYK 
printing process. 
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Exchanging cyan ink using Edit Primaries
FIG 5.4
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Using Edit Primaries
ColorLogic's suggested workflow: 
Load another data set with the 
measured new primaries, gradations 
of the primaries 
and overprint 
information.
Select the 
measurement data 
of a test chart 
measurement file 
for editing and click 
Edit Primary.

Exchanging a 
primary: Click on 
the eyedropper 
icon of the color 
to be exchanged. 
Select the new pri-
mary from another 
data set loaded in 
ColorAnt. Click 
on the channel to 
be imported to 
the primary. The 
screenshot shown 
(Fig 5.4) with a 
new Cyan ink that 
is slightly different. 
Selecting ink from 
other channels is 
also possible. 
Click OK and the data set will be 
modified.
Important: Using Lab values will not 
produce the highest quality results. 
ColorLogic recommends using spec-
tral data. When a data set is present, 
enter a new Lab value for the select-
ed color or select another channel 
from the same measurement data set 

to change the printing order.
To check the exchange of primaries, 
use the Compare tool to verify the 
data.

Exchange paper/
substrate
Load the test chart measurement 
data and load the secondary file con-
taining information of the measured 
paper white into ColorAnt.
Select the measurement data of a 
test chart for editing and click Edit 
Primaries.

EDITING

Exchanging paper white using Edit Primaries
FIG 5.5
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Click on the eyedropper icon of the 
Substrate/White and select the new 
paper white from another data set 
loaded in ColorAnt (Fig 5.5) Click on 
the name of the data set to import 
the data. The second option is to 
manually enter the 
new Lab values in 
the text field.
Click OK and the 
data set will be 
modified.
For large differenc-
es in substrates, 
use the White/
Black correction 
tool.

Adding 
channels
Load the test chart 
measurement data 
and load the sec-
ondary information 
with the measured 
primaries, grada-
tion and overprint 
information into 
ColorAnt.
Select the measurement data of a 
test chart for editing and click Edit 
Primaries.

Quick Start Procedure
Step one: Click on Add Channel. A 
new channel with default gray Lab 
values and the channel name Auto is 
added.
Step two: Click on the eyedropper 
icon of the new channel and select 
the new primary from another data 

set loaded in ColorAnt. Click on the 
channel to import the data.
The screenshot shows an example 
where a 5th Orange color (Fig 5.6)
has been added to an original CMYK 
data set. 

To rename the channel click on the 
pencil icon and enter the new chan-
nel name.
Step three: Click OK to generate 
the new data set. 
To view the new data set, use the 
View tool and select the tabs 2D, 3D, 
SpiderWeb, TVI to verify all colors in-
cluding overprints have been added. 
Additional edits can be made to the 
curves using the Tone value tool.
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Adding a channel with Edit Primaries
FIG 5.6



34

Removing channels
Load and select the measurement 
data of a test chart and click Edit 
Primary.

Disable the check boxes in front of 
the channels that need to be deleted 
and click OK.
The new data set will be reduced to 
the channels that were selected.
Color Editor 
Used to edit color patches and to 
process color conversions of spot 
colors. 

Quick Start Procedure
Color Editor allows the user to:
Edit patch names, (Fig 5.7) Lab values 
or device color values (DCS). 
Convert and optimize a complete 

spot color library to a target profile 
for RGB, CMYK or Multicolor. 
To convert spot colors to a desired 
target profile, first load the spot 
colors into the ColorAnt Data Sets 
section, e.g. a Pantone spot color 
library (or any supported file format 
such as CxF), then click on Color 
Editor. The window contains a table 
on the left showing all spot colors of 
the file and the editing options on 
the right. Select an ICC Profile from 
the drop down list and a calculation 
Mode. 

Three modes are available: 

Precise Match - Proofing 
Visual Match - Utilize More 
Channels 
Use the Least Amount of Channels 
The preset dE Limit highlights colors 
that exceed the defined threshold 

Color Editor dialog
FIG 5.7
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If a color is selected from the table, 
the device color values for each 
channel of the selected profile are 

shown under Optimize Destination 
Values. As a default, the device values 
calculated via the ICC profile are 
shown without any optimization. By 
clicking on dE76 or dE00 the deltaE 
can be minimized (Fig 5.8) for each 
color. Clicking on Automatic applies 
the selected calculation Mode which 
typically results in a reduced amount 
of channels for better print-ability. 
Users can optimize each individual 

color and can even enter device 
values manually. By clicking on Start, 
the entire list of colors is generated 

in the Data Sets section including 
the calculated and possibly optimized 
device color values. The values can 
be saved for further usage in other 
applications in any format supported 
by ColorAnt (CGATS TXT and XML, 
CXF3, Photoshop ASE and ACO, 
named color ICC profile or GMG 
CSC).

Color Editor correct data to a profile
FIG 5.8
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